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Workflow spreadsheets set-up guide 
 

This Workflow spreadsheets set‑up guide forms part of the broader suite of tools within the In‑reach 
Rehabilitation Toolkit. It serves as a step-by-step template resource for clinical services. This guide walks 
you through building structured MS Excel workbooks to track and monitor incoming referrals and patient 
movements. Example versions of the spreadsheet are included in the In-reach Rehabilitation Toolkit.  

Workflow sheets are provided for data collection and are separated into two streams:  

• Incoming referrals  

• Current patients  

Workbook - incoming referrals 

The incoming referral spreadsheet is typically utilised by the in-reach medical team, CNC or senior allied 
health professionals (AHPs) to monitor the incoming referrals and the outcome of their assessment. Data 
collection is necessary to identify the throughput of patients through the In-reach service, as outlined in the 
Evaluation framework resource. To maintain usability, it is recommended to create and save spreadsheets 
on a monthly basis to prevent files from becoming overloaded with large volumes of patient data. 
Additionally, lines of patient data that are no longer current e.g. seen and declined or accepted/on the 
program, may be temporarily hidden during the month to maintain visibility of higher priority data sets 
including those currently awaiting assessment.  

Workbook - current patients 

The spreadsheet for current patients is typically utilised by the entire in-reach multidisciplinary team (MDT) 
to track current patient packages including key data sets. Similarly to the above incoming referrals 
spreadsheet, the current patients sheet it is recommended to create and save spreadsheets on a monthly 
basis to prevent files from becoming overloaded with large volumes of patient data. The current patients list 
should only include current active patients. Once discharged/completed, they can be moved to a below the 
current patients table or hidden and entered into the discharge patients sheet. This ensures that the coding 
for the name and URN remains consistent between sheets. In the discharged patient sheet, patients may 
be hidden temporarily once all datasets have been completed to maintain visibility of patients that have 
outstanding data requirements.  

Following is a set-up guide for both worksheets.  

 

1. Set up guide – Incoming referrals workbook – overview  
The workbook for tracking incoming referrals requires four sheets: 1) received referrals, 2) monitor, 3) 
waitlist, and 4) lists (hidden). The Lists sheet stores drop-down options to standardise entries across the 
workbook. 

Additional sheets can be added depending on what is required for your workflows. This set-up guide acts 
as a reference for relevant codes to optimise efficiency but is not prescriptive and can be adjusted as 
required. At a minimum, all services should collect data as per the minimum data requirements outlined in 
the In-reach rehabilitation model of care and Evaluation framework resource. Note that workflow 
management can be completed via alternative means such as SharePoint or Microsoft Lists, with 
consideration that this typically requires more complex coding and maintenance.  

Example spreadsheets (if utilised) should be saved as a blank template and replicated for timeframes that 
support team data management e.g. monthly or quarterly to support reporting timeframes. You can 
consider additional modifications to this document including conditional formatting and colour coding to 
continue to improve the usability.  



 

Queensland Government 

 

Workflow spreadsheets set-up guide,  

In-reach Rehabilitation Toolkit, V1.0 

2. Referral sheets set-up 
Open a new Excel workbook. Add new sheets named ‘Received Referrals’ ‘Monitor’, ‘Waitlist’, and ‘Lists’. 

The incoming referrals will be monitoring via the main “Received Referrals’ tab. For patients that are 
currently on the monitor list and waitlist, they should be added to the additional sheets to maintain visibility 
for patients that are requiring active oversight following assessment.  

2.1 Build the Lists sheet  

In the Lists sheet, enter a table with the following standardised options: 

Label each column with any relevant multiple-choice option for the sheets. At a minimum, you will likely 
require the following table set-up.  

Referral Source Sex  Status Outcome Priority  

Neuro  Male Referral Received Accepted Urgent 

Stroke Female Awaiting Ax  Declined   High  

General 

Medicine 

Inter/NB Ax Completed  Monitor  Medium 

General Surgery    Awaiting Ax Low  

Other     

This sheet will then be the data that is available for any drop-down multiple-choice option in other sheets. 

Alternative or additional options can be easily added to this list to adjust the drop-down options. Once you 

are satisfied that the data is complete and the sheet is finalised, you can hide it to reduce clutter. 

2.2 Received referrals sheet 

Add headers: Date Received, Referral Source, Referrer Contact, URN, Patient First Name, Patient 

Surname, DOB, Age, Sex, HPC/Clinical Summar, Status, Outcome.  Convert the range to a Table 

(Highlight, then Insert → Table, ensure relevant data is include and tickbox selected for Headers) to enable 

filtering. 

Apply Data Validation for Referral Source, Sex, Status, and Outcome using the Lists sheet using the 

following steps:  

Select relevant column (e.g.Referral source) → Data → Data Validation → Allow: List → Source: 

=Lists!$A$2:$A$6 OR manually highlight Referral Source column in Lists Sheet (with no header included). 

The source will change dependent on the list e.g. Sex =Lists!$B$2:$B$4.  

To add Age formula in column H (starting H2): 

=IF(G2="","",DATEDIF(G2,TODAY(),"Y")) 

Highlight H2 and “drag” down the column to ensure this code applies to all rows below it. This means to fill 

down.  This will ensure that as patient data is included, age will automatically be calculated based on DOB.  
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2.3 Monitor patient sheet 

Add headers: URN, Patient Name, Date of Referral, Date of Assessment, Days on Monitor List, Reason for 

Monitor. 

In Patient Name (cell B2), enter the XLOOKUP formula below and fill down: 

=IFERROR(IF(A2="","",XLOOKUP(A2,'Received Referrals'!$D$2:$D$1000,'Received 

Referrals'!$E$2:$E$1000&" "&'Received Referrals'!$F$2:$F$1000,"")),"" 

In Referral Date column (cell C2), enter the XLOOKUP formula below and fill down:  

=IFERROR(IF(A2="","",XLOOKUP(A2,'Received Referrals'!$D$2:$D$1000,'Received 

Referrals'!$A$2:$A$1000,"")),"") 

These steps will ensure that whenever the URN is entered into the sheet, the full name and referral date will 

be automatically entered using the data from the Current Patient sheet.  

Apply Data Validation: Priority for Assessment → =Lists!$E$2:$E$5; or manually highlight the list of Patient 

Priority Options in the Lists Sheet.  

Users will then have to manually add the Date of Assessment and Reason for Monitor.  

Reason for Monitor can be used as Free Text box or additional standardised options could be considered 

and added to the Lists Sheet and validated using the same method as other drop-down options.  

For days on Monitor list. The following formula can be applied to automatically calculated based on time 

since the date of assessment: =IF(D2="","",MAX(0,TODAY()-D2)) 

2.4 Waitlist sheet 

Add headers: URN, Patient Name, Referral Date, Assessment Date, Days on Waitlist, Priority for Package. 

In patient name and referral date, the above XLOOKUP formulas can be used to ensure that the patient 

name is linked with the URN.  

As above, Days on the waitlist can be automatically calculated by using the same formula:  

=IF(D2="","",MAX(0,TODAY()-D2)) 

3. Set up guide - Patient movement workbook - overview 
In the patient tracking spreadsheet, create 4 sheets: Current Patients, Outcome Measures, Discharged 

Patients, and Lists (hidden). The Lists sheet stores drop-down options to standardise entries across the 

workbook. 

Additional sheets can be added depending on what is required for your workflows. This Set-up guide should 
act as a reference guide for relevant codes to optimise efficiency but is not prescriptive and can be adjusted 
as required. At a minimum, all services should collect data as per the minimum data requirements outlined 
in the In-reach Rehabilitation model of care and Evaluation Framework resource. Note that workflow 
management can be completed via alternative means such as SharePoint or Microsoft Lists, with 
consideration that this typically requires more complex coding and maintenance.  

If utilised, the example spreadsheets should be saved as a blank template and replicated for timeframes 
that support team data management e.g. monthly or quarterly to support reporting timeframes. You can 
consider additional modifications to this document including conditional formatting and colour coding to 
continue to improve the usability.   

4. Patient movement sheets set-up  
Open a new Excel workbook. Rename the default sheet to ‘Current Patients’. Add new sheets named 

‘Team Allocation’, ‘Outcome Measures’, ‘Discharged’, and ‘Lists’. 
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4.1 Build the Lists sheet  

In the Lists sheet, enter a table with the following standardised options: 

Label each column with any relevant multiple-choice option for the sheets. At a minimum, you will likely 

require the following table set-up.  

Yes/No Sex Teams Key Worker Referring Team D/C 
Destinations 

Yes Male Blue (Physio 

Name) 

Neuro  Home 

No Female Red (OT Name)  Stroke Sub-acute 

Rehab  

 Inter/NB Yellow (SP Name)  General 

Medicine 

Step-Down 

Bed  

    General 

Surgery  

RACF  

    Other Acute Ward  

 

Note that the options included in this table should be relevant to your service e.g. Key Worker should be 

members of your team and referring team options should be included based on your typical or planned 

referrers. Similarly for discharge destinations, these will be specific to your typical or planned and can be 

adjusted at any time.  

This sheet will then be the data that is available for any drop-down multiple-choice option in other sheets. 

Once you are satisfied that the data is complete and the sheet is finalised, you can hide it to reduce clutter. 

4.2 Current patient sheet 

Add headers: First Name, Surname, UN, DOB, Age, Sex, HPC, Impairment Code, Team and Key Worker. 

Additional headers/columns should be included for all disciplines within the workforce (e.g. Physiotherapy, 

occupational therapy, CNC, speech pathology etc.). Convert the range to a Table (Highlight, then Insert → 

Table, ensure relevant data is include and tickbox selected for Headers) to enable filtering. 

Set Sex as a drop-down: Select column F → Data → Data Validation → Allow: List → Source: 
=Lists!$B$2:$B$4 OR manually highlight Yes/No column in Lists Sheet (no header included).  

Add Age formula in column E (starting E2): 

=IF(D2="","",DATEDIF(D2,TODAY(),"Y")) 

Highlight D2 and “drag” down the column to ensure this code applies to all rows below it. This means to fill 

down.   

This will ensure that as patient data is included, age will automatically be calculated based on DOB. Sex 

can also be selected from drop down options.  

Under the Team Allocation header, the following data validation should be included: Apply Data Validation: 

Team Allocation → =Lists!$C$2:$C$9; or manually highlight the list of teams in the Lists Sheet. The teams 

are labelled as colours in the example but can be labelled in any way suitable for the individual service.  
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Under the Key Worker column, the following data validation should be applied → =Lists!$D$2:$D$6 

Under each of the discipline columns, the following validation should be included for yes/no selection of 
which disciplines are involved or have been referred for each patient.  

Yes/No columns → =Lists!$A$2:$A$3 or manually highlight the yes/no columns in the Lists Sheet.  

4.3 Outcome measure sheet 

Add headers: URN, Full Name, Referring Team, Estimated Discharge Date, Estimated Discharge 

Destination, FIM - Admission Total, FIM - Discharge Total, Goals. Additional headers can be added for any 

additional patient outcomes used within this team  

Apply data validation: Referring Team → =Lists!$E$2:$E$6;  

Destination → =Lists!$F$2:$F$6;  

For additional outcome measures, drop down options can be applied using the same lists and data 

validation steps as above. To maintain accountability for additional tasks (e.g. completion of patient survey 

or provision of resources) yes/no can be included as well following the same steps.  

Use the same Full Name XLOOKUP in column B: 

=IFERROR(IF(A2="","",XLOOKUP(A2,'Current Patients'!$C$2:$C$200,'Current 

Patients'!$A$2:$A$200&" "&'Current Patients'!$B$2:$B$200,"")),"") 

As above, this step ensures that the patient’s name is included in the table when the URN is entered.  

4.4 Discharged patient sheet 

This sheet will be used once patients have been discharged from the service to monitor necessary actions. 

The following headers are examples of key discharge actions, but additional items can be included 

depending on typical workflow for your service.  

Add headers: URN, Patient Name, Discharge Date, Survey Completed, AROC Data Completed, Discharge 

Summary Completed. 

Use the same Full Name XLOOKUP in column B: 

=IFERROR(IF(A2="","",XLOOKUP(A2,'Current Patients'!$C$2:$C$200,'Current 

Patients'!$A$2:$A$200&" "&'Current Patients'!$B$2:$B$200,"")),"") 

Apply Yes/No validation to columns D–G using =Lists!$A$2:$A$3. Format as a table for filtering. 

Optional conditional formatting could be applied with colour coding for yes/no items to improve awareness 

of tasks that require actioning.  

 

5. Hide the Lists sheet 
In each workbook, the lists sheet can be hidden to improve clarity and usability. Right-click the Lists tab and 

choose ‘Hide’. You can unhide later to edit options or list content. 
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6. Test the setup  
In each workbook, the set-up can be tested by using an example or test patient using the following steps for 

each workbook:  

Referrals:  

• Add a patient in Received Referrals.  

• Enter the same URN on Awaiting Assessment, Declined, Monitor and Waitlist to ensure data 
correlating across sheets.  

• Confirm Full Name and Referral Date appears automatically.  

• Add date of assessment in Monitor and Waitlist sheets to ensure days calculation correct.  
o Troubleshooting: If a number appears that is not a date, change formatting in “Number” on 

home section of tool bar to Short Date.  

• Check drop-downs work.  
 
Patient movement:  

• Add a patient on Current Patients.  

• Enter the same URN in the Outcome Measures and Discharge Patients sheet.  

• Confirm Full Name appears automatically.  

• Check drop-downs work.  
 
 
 

Appendix A: Referrals - formulas 
Copy and paste the following as required.  

Patient Name: 

=IFERROR(IF(A2="","",XLOOKUP(A2,'Received Referrals'!$D$2:$D$1000,'Received 

Referrals'!$E$2:$E$1000&" "&'Received Referrals'!$F$2:$F$1000,"")),"") 

Referral Date: 

=IFERROR(IF(A2="","",XLOOKUP(A2,'Received Referrals'!$D$2:$D$1000,'Received 

Referrals'!$A$2:$A$1000,"")),"") 

Days on Monitor/Waitlist: 

=IF(D2="","",MAX(0,TODAY()-D2)) 

 

Appendix B: Patient tracking - formulas 
Copy and paste the following as required.  

Full Name (Team Allocation!B2 and Outcome Measures!B2): 

=IFERROR(IF(A2="","",XLOOKUP(A2,'Current Patients'!$C$2:$C$200,'Current 

Patients'!$A$2:$A$200&" "&'Current Patients'!$B$2:$B$200,"")),"") 

Age (Current Patients!E2): 

=IF(D2="","",DATEDIF(D2,TODAY(),"Y")) 

INDEX/MATCH alternative (for older Excel versions without XLOOKUP): 

=IFERROR(IF(A2="","",INDEX('Current Patients'!$A$2:$A$200, MATCH(A2, 'Current 

Patients'!$C$2:$C$200, 0)) & " " & INDEX('Current Patients'!$B$2:$B$200, MATCH(A2, 

'Current Patients'!$C$2:$C$200, 0))),"") 

 


